
  
    
  


  
    Adobe After Effects


    O essencial em Motion Graphics e VFX


    


    Alex Affonso


    Editora Senac São Paulo – São Paulo – 2022

  


  
    
       


      Apresentação

    


    O que é a Série Informática


    A Série Informática foi desenvolvida para que você aprenda sozinho, sem o acompanhamento de um professor. Neste volume, você vai entrar no universo de possibilidades infinitas que é o After Effects. Vamos desvendar a magia de trabalhar com Motion Graphics e criar animações do zero, combinando recursos e efeitos para dar luz àquelas imagens que, antes de se tornarem realidade, existem apenas na nossa cabeça criativa.


    Equipamento necessário


    Para você estudar com este material, é importante que seu computador tenha as configurações mínimas listadas a seguir.


    Windows


    
      	
Processador: Multicore Intel com suporte a 64-bit.


      	
Sistema operacional: Microsoft Windows 10 (64 bit) versão 1903 ou superior. Importante: a versão 1607 do Windows não é suportada.


      	
Memória RAM: 16 GB no mínimo (32 GB recomendados).


      	
Placa gráfica GPU: 2 GB de VRAM. A Adobe recomenda a atualização do driver NVIDIA para a versão 451.77 ou mais recente ao usar o After Effects. Versões anteriores apresentam problemas e podem travar o software.


      	
Espaço em HD: 5 GB de espaço disponível em HD; espaço livre adicional necessário durante a instalação (não pode ser instalado em dispositivos de armazenamento removíveis). Espaço adicional de 10 GB recomendado para armazenamento de arquivos temporários (cache).


      	
Resolução do monitor: 1280 × 1080 ou maior.


      	
Internet: A conexão à internet e o registro são necessários para ativação do software, validação da assinatura e acesso aos serviços on-line.

    


    Versão para Mac


    
      	
Processador: Multicore Intel com suporte a 64-bit.


      	
Sistema operacional: macOS versão 10.14 ou mais recente. O macOS Big Sur é suportado na versão 17.5.1 do After Effects.


      	
Memória RAM: 16 GB no mínimo (32 GB recomendados).


      	
Placa gráfica GPU: 2 GB de VRAM.


      	
Espaço em HD: 6 GB de espaço disponível em HD; espaço livre adicional necessário durante a instalação (não pode ser instalado em um volume que use sistema de arquivos com diferenciação entre letras maiúsculas e minúsculas em dispositivos de armazenamento removíveis). Espaço adicional de 10 GB recomendado para armazenamento de arquivos temporários (cache).


      	
Resolução do monitor: 1440 × 900 ou maior.


      	
Internet: A conexão à internet e o registro são necessários para ativação do software, validação da assinatura e acesso aos serviços on-line.

    


    Para mais detalhes sobre os requisitos mínimos do After Effects e dos demais softwares da Adobe, acesse a página oficial, disponível em: https://helpx.adobe.com/support.html,[1] e digite “requirements” no campo de busca.


    E a versão do After Effects, qual deve ser?


    Embora todos os exercícios desenvolvidos ao longo do livro tenham sido criados e finalizados no After Effects 2020, você pode usar qualquer outra versão dele para aprender e fazer exatamente as mesmas coisas. As atualizações constantes implementadas pela Adobe ano após ano no After Effects trazem sempre maneiras novas e mais elaboradas de trabalhar, mas nada que mude a essência do software e a forma como ele funciona. Ou seja, desde que esteja utilizando a versão 2015 ou superior do After Effects, tudo o que é explicado neste livro pode ser feito de igual maneira.


    Entretanto, para abrir os projetos fornecidos nos arquivos de exercícios, você precisará ter o After Effects 2020 (v17.6.0 Build 46) instalado. Minha recomendação é de que você mantenha seu software sempre atualizado na última versão, uma vez que as atualizações não apenas corrigem possíveis problemas e falhas como também trazem novos recursos. Não é à toa que, quando abrimos o After Effects, sempre apareça a janela de boas-vindas com dicas, tutoriais e, acima de tudo, informações sobre as novidades mais recentes.
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    A estrutura do livro


    Cada capítulo foi elaborado com o objetivo de que você descubra um novo recurso, uma nova forma de trabalhar, uma nova possibilidade criativa, para entender o principal: a dinâmica da poderosa ferramenta que é o After Effects.


    Você aprenderá, a cada etapa, que tudo depende de quanto esta ou aquela opção vai levar àquele resultado que você projetou. De forma orgânica, como quando você segura uma caneta para escrever e nem sequer pensa na caneta, você verá que, ao final, terá domínio sobre o After Effects e terá prazer em se entregar a ele e mergulhar de cabeça nas suas composições.


    Não ache estranho se você passar horas (ou dias) apertando botões e arrastando linhas ou números sem perceber o tempo passar: isso é o resultado esperado. Ora, todo artista, quando mergulha em seu universo criativo, deixa-se perder por ele enquanto, quase sem pensar, manipula suas ferramentas, até que sua obra de arte esteja finalizada.


    Você começará reconhecendo o software, entendendo para que servem os painéis e a trabalhar com a interface. Logo depois, no segundo capítulo, você já criará um projeto e, usando recursos fundamentais, terá informação e conhecimento suficientes para ir em frente e explorar, nos capítulos seguintes, os keyframes, os gráficos e tudo aquilo que permite a criação de muito mais do que apenas a variação premeditada de valores como posição e escala ao longo do tempo, por exemplo.


    Então, sabendo utilizar as mais diversas possibilidades de controle da animação, você aprenderá a criar cenários e animá-los, a criar sobreposição e trabalhar com Chroma Key (fundo verde), a criar espaços/cenários tridimensionais e a usar programação em JavaScript, chamada de expressions, para ir muito além e trazer a naturalidade da aleatoriedade, entre outras coisas, para seus projetos.


    Como a música desempenha um papel fundamental no audiovisual, o trabalho com sons também será abordado. A música, inclusive, pode ser usada como norte da animação, definindo seu ritmo.


    Ao concluir o projeto, você aprenderá como exportá-lo de modo que ele possa ser reproduzido em todas as mídias, da televisão ao cinema, do monitor do computador à tela do celular.


    Leia com atenção todos os itens do livro, pois sempre encontrará informações úteis para a execução das atividades. E conheça, abaixo, o significado dos símbolos colocados ao lado de determinados trechos do texto, porque eles servem para orientar seu trabalho.


    Faça o download das atividades no link abaixo: http://www.editorasenacsp.com.br/informatica/adobe_after_effects/atividades.zip


    Como usar os arquivos de exercícios


    Os capítulos possuem arquivos de exercícios que podem ser usados por você para replicar aquilo que é explicado ao longo das lições.


    Depois de baixar e descompactar os arquivos, você terá uma pasta para cada capítulo e, dentro delas, todas as imagens que são utilizadas nos exercícios. Você poderá, então, ir por dois caminhos:


    
      	criar seus próprios projetos e importar as imagens para eles conforme a maneira explicada, para replicar aquilo que proponho do zero e se acostumar com a criação de projetos, tendo ciência de tudo o que é necessário configurar desde o início; ou


      	abrir os projetos que preparei para este livro, que também estão nas pastas de cada capítulo.

    


    Como exemplo, vamos usar a pasta do capítulo 2. Você encontrará dentro da pasta:


    
      	uma música em formato .mp3;


      	um logotipo desenhado no Illustrator em formato .ai;


      	dois filmes em formato .mp4;


      	dois projetos do After Effects (início e final) em formato .aep.
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    Você pode começar o exercício de cada capítulo: (1) ou abrindo o projeto inicial, (2) ou criando o projeto do zero (executando o passo a passo). E você pode também abrir o projeto final caso queira investigar como eu finalizei cada exercício e ver a forma como deixei as configurações de cada parâmetro alterado. Explorar o projeto de outro profissional é um modo importantíssimo de estudar o After Effects, tal qual é, para os programadores, investigar websites de seus colegas.


    Espero ser o responsável por desmistificar tudo aquilo que possa parecer, pelo menos à primeira vista, difícil e complicado. Você verá que não é!


    Introdução


    Antes de começarmos a trabalhar com o After Effects, peço licença para falar um pouco sobre o que dominar um software como esse representa para mim. Quero, com isso, mostrar como tudo é possível quando você entende as nuances de cada detalhe.


    Quando comecei a trabalhar com o After Effects, eu criava e produzia trailers de games para computador, daqueles que eram lançados em CD nas bancas de jornal por uma empresa que dominava o mercado nacional na época e tinha suas revistas espalhadas por todo o país.


    Naquele tempo, eu precisava ir além de apenas capturar imagens e sequenciá-las; eu precisava de muito mais do que apenas contar uma história. Era preciso impressionar, era preciso despertar nos leitores da revista a vontade de jogar. E foi aí que o After Effects entrou na jogada.


    Depois de editar alguns trailers no Adobe Premiere 4.2, que ainda não era Pro, e todos sempre diziam que os editores trabalhavam mesmo era com o Final Cut, apostei na ideia de que usar o software da mesma empresa que desenvolvia o Photoshop era a melhor alternativa. Isso me daria liberdade para criar de forma mais orgânica o que eu precisasse no Photoshop e integrar àquilo que eu estava editando no Premiere, mesmo que na época a integração entre eles não existisse de fato.


    Foi então que, em 1998, essa minha jornada pelo audiovisual começou. Até aquele ano, eu já havia passado pelo curso de educação artística na Unesp e cursava letras na USP. Mais tarde, voltaria para a educação artística na Unesp, pois é na arte (e em línguas e literatura) que eu sempre me encontrei.


    Percebendo o potencial que existia em trabalhar com Motion Graphics usando o After Effects para aprimorar as minhas edições e poder de fato criar algo novo sobre aquelas imagens incríveis que os games já tinham, não restou dúvida: eu precisava aprender a usá-lo.


    Na primeira vez em que abri o After Effects 4.0, foi mais choque do que qualquer outra coisa, e um sentimento de impotência tomou conta de mim. Depois de olhar para a interface vazia dele por 5 minutos e não entender sequer como começar um projeto, eu simplesmente o fechei e me conformei em continuar trabalhando apenas com o Premiere.


    Mas aquele sentimento durou pouco, já que eu sempre fui autodidata e investigativo. Não era uma tela vazia de um programa que não mostrava nada, mesmo quando se iniciava um novo projeto pelo comando File > New Project, que iria me abater.


    Abri o After Effects de novo e, acessando cada comando de cada menu, descobri: era necessário criar uma nova composição, e não apenas um novo projeto. Era assim, então, que tanto o painel Timeline quanto o Composition apareciam. Dali em diante, as coisas fluíram muito bem, pois eu percebi aquilo que sempre digo a todos os meus alunos quando começamos um novo curso de After Effects: ele é o Photoshop para vídeo e animação.


    Você notará, ao longo dos exercícios deste livro, que tudo no After Effects é criado com base na timeline, que nada mais é do que o painel Layers do Photoshop, munido de tempo. São infinitas as possibilidades de combinação e manipulação das camadas ao longo do tempo, e essa dinâmica torna possível criarmos não só uma sequência de imagens mas também uma sequência de acontecimentos variados que vão se desdobrando, evoluindo e revelando tudo aquilo que vemos na nossa cabeça enquanto projetamos uma nova animação, um novo efeito, um novo projeto.


    O software não deve definir o que você cria. Pelo contrário: somos nós que projetamos o que queremos fazer. Conhecendo as potências do software, usamos o programa como ferramenta para criar nossa arte, nossa animação, nossos efeitos, e para trazer às telas um universo gigantesco de elementos que interagem entre si e criam, no espectador, as mais diversas sensações, as mais diversas percepções. Somos nós os responsáveis por, através dos efeitos visuais, ajudar a transmitir a mensagem de um filme, um comercial, um videoclipe, uma vinheta. Carregamos essas criações de intenções diversas a serem descobertas e consumidas pelo espectador.


    E foi ao longo de mais de vinte anos trabalhando com o After Effects e, mais do que isso, ensinando milhares de pessoas a usá-lo com consciência, dominando sua dinâmica e sabendo como explorar suas infinitas possibilidades, que descobri que ele é a ferramenta que mais gosto de usar, que consegue me deixar mergulhado em um mundo no qual a cada segundo uma nova coisa acontece, um novo elemento ganha vida – e sou eu quem controla esse mundo.


    Reserve tempo para estudar e praticar os exercícios propostos neste livro. E que esse mergulho seja, para você, não só produtivo e revelador como também prazeroso.


    Boa leitura, bom estudo e boa viagem!


    
      
        [1] Acesso em: 14 set. 2021.
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      Visão geral do After Effects


      OBJETIVOS


      
        	Organizar a área de trabalho


        	Aprender o que é e como criar um projeto


        	Aprender a importar arquivos


        	Conhecer os diversos painéis do After Effects

      

    


    O After Effects pode parecer assustador à primeira vista, principalmente ao vermos tudo o que ele nos oferece e como tantas e tantas possibilidades fazem dele um software tão poderoso. Não é surpresa que sua interface intimide até os usuários dos softwares Adobe mais experientes, pois ela traz diversos painéis com muitas opções que, dependendo do seu objetivo e do projeto, nem sequer são necessárias. Por isso, para nos familiarizarmos com a interface do software e suas diversas facetas, não podemos começar senão por ela, por seus painéis e pelos diferentes modos de organizar a área de trabalho.


    Reconhecendo a área de trabalho


    Ao abrir o After Effects pela primeira vez, você será apresentado à tela de boas-vindas, conhecida como Home.


    
      Caso você queira redefinir as preferências do After Effects, basta iniciá-lo a partir da pasta Aplicativos no macOS ou do menu Iniciar no Windows e, logo na sequência, pressionar e manter pressionadas as teclas Cmd+Option+Shift (macOS) ou Ctrl+Alt+Shift (Windows). Basta clicar em OK na janela que aparecerá para redefinir todas as preferências do software, e seu After Effects abrirá com as configurações-padrão, sem nenhuma modificação feita pelo usuário.

    


    Embora seja muito comum ignorarmos a janela de boas-vindas e logo fechá-la, ela traz uma gama de tutoriais criados e selecionados pela própria Adobe para ajudá-lo a começar a usar o After Effects ou aprimorar sua técnica, com dicas e truques de profissionais da área de Motion Graphics. Esses tutoriais, divididos entre os interativos (apresentados dentro do próprio software) e aqueles da web (no site da Adobe), estão localizados na opção Learn, à esquerda.
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    Essa janela também traz outras opções, como Sync settings, New project e Open project. Todas elas, ainda que aqui estejam como atalhos para começarmos a trabalhar com o After Effects, são encontradas no menu File tradicional, que vamos explorar aos poucos, conforme precisarmos dele.


    Fechar a janela Home nos leva direto para a área de trabalho do After Effects, especificamente a padrão, chamada Default. No topo da interface, há diversas áreas de trabalho, que podemos escolher de acordo com o que estamos fazendo. Essas áreas de trabalho nada mais são do que organizações diferentes dos diversos painéis existentes no software, uma forma de filtrar as opções disponíveis e facilitar o acesso a elas quando mais precisamos. Ao longo dos exercícios deste livro, nós usaremos diversas delas, como Effects, Color, Text e Essential Graphics, por exemplo. A última das opções, chamada Edit Workspaces, dá acesso à janela pela qual podemos organizar sua ordem e definir aquelas que queremos manter visíveis na barra superior, facilitando o acesso.
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    Usando a opção Edit Workspaces, organize os atalhos das áreas de trabalho para que eles fiquem como na imagem mostrada abaixo.


    
      [image: ]
    


    Além da possibilidade de alternar entre as áreas de trabalho já existentes, você pode criar as suas próprias, organizando os painéis da maneira que lhe for mais apropriada. Para isso, basta arrastar o painel desejado para a área da interface que queira e ajustar sua largura e sua altura. Você notará que, ao arrastar painéis pelo nome, uma mancha lilás ou esverdeada (apenas em algumas áreas) aparecerá sobre a interface. Essa mancha destaca a região na qual o painel arrastado será colocado.


    Na imagem a seguir, o painel Effects foi arrastado para o centro do painel Project. Dessa forma, ele ocupará o mesmo espaço da interface, e por isso naquela área será possível ver apenas um desses painéis por vez. Entretanto, ao soltarmos um painel na mancha lilás que aparece nas laterais de outro, ele será colocado ao lado, e os dois permanecerão visíveis simultaneamente na interface.


    
      [image: ]
    


    
      [image: ]
    


    Muitos outros painéis estão disponíveis no menu superior Window, local padrão utilizado pela Adobe em todos os seus softwares para essa finalidade. Basta selecionar o painel desejado para que ele seja colocado, inicialmente, em seu local padrão da área de trabalho.


    Depois de abrir os painéis desejados, organizá-los e definir exatamente como você deseja que sua área de trabalho seja salva, basta entrar novamente no menu Window, selecionar a opção Save as New Workspace e digitar o nome desejado. Pronto! Sua nova área de trabalho será mais uma opção que poderá ser selecionada nesse menu.
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      Após modificar qualquer área de trabalho, caso você queira redefini-la às configurações de fábrica, basta entrar novamente no menu Window > Workspace, verificar se ela ainda está selecionada e clicar na opção Reset “…” to Saved Layout.

    


    Agora que você já sabe como organizar e já entende como a área de trabalho do After Effects funciona, vamos criar um novo projeto para explorarmos os principais painéis e suas funções.


    O que é e como criar um projeto no After Effects


    Para poder importar imagens, vídeos, desenhos, músicas, efeitos sonoros e quaisquer outros arquivos compatíveis com o After Effects e começar a criar com eles na timeline, é preciso primeiro criar um projeto. O projeto nada mais é do que o arquivo do After Effects, cuja extensão é .aep, que armazena não só o vínculo com todos os seus arquivos mas também todas as configurações que você fizer no decorrer do seu trabalho.


    Mesmo que você não tenha clicado no botão New Project na janela Home nem executado o mesmo comando por meio do menu File, você perceberá que o After Effects já mantém, por padrão, um projeto sem título aberto. Por esse motivo, é muito comum ignorarmos a janela Home e já partirmos para a importação de mídia. No entanto, é imprescindível notar que esse projeto não está salvo em local algum, e isso é um grande risco. Ao longo dos últimos vinte anos em que trabalho com o software, já vi muitos profissionais perderem projetos inteiros por se esquecerem de salvar e sair criando suas animações logo de cara. Pode parecer um erro tolo, mas é de fato muito comum.


    Portanto, antes de mais nada, sugiro que você acesse o menu File e já selecione o comando Save As > Save As (Cmd+Shift+S, no macOS, ou Ctrl+Shift+S, no Windows), escolha um local em seu computador para salvar, defina um nome para esse primeiro projeto e só então siga adiante.
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    Com o projeto agora salvo, outra medida de segurança é ativar (ou verificar) o salvamento automático. Essa é uma das configurações essenciais do After Effects e, como muitas outras, encontra-se no menu After Effects > Preferences (macOS) ou no Edit > Preferences (Windows). Você pode definir o intervalo de tempo do salvamento automático, o número máximo de versões salvas e a pasta na qual quer que tais arquivos sejam armazenados. Atente para o fato de que os projetos salvos automaticamente serão cópias do seu projeto original no momento do salvamento. Por isso, eles estarão dentro de uma pasta chamada After Effects Auto-Save, no local indicado por você. Se possível, defina esse local em um HD ou SSD diferente daquele em que seu projeto original está sendo salvo, para garantir mais segurança contra falhas de disco.
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    Importação de mídia


    Como nosso objetivo neste momento é apenas nos familiarizarmos com os diversos aspectos de uso do After Effects, vamos importar alguns arquivos para que possamos criar uma composição, bem como sua timeline, e explorar os diversos painéis aos quais devemos estar o tempo todo atentos.


    Há diversas maneiras de importar arquivos para qualquer projeto no After Effects.A mais tradicional é a que vamos usar conforme as etapas apresentadas a seguir.


    Exercícios


     1. Clique no menu File e selecione o comando Import > File.


     2. Na janela que se abrir, de acordo com seu sistema, navegue até a pasta de exercícios C01 - Intro.


     3. Selecione os três arquivos de mídia da pasta ao mesmo tempo. Você terá nela um logotipo em formato nativo do Illustrator (.ai), um vídeo (.mp4) e uma música (.mp3). Todos esses formatos, bem como .jpg, .png, .psd, .wav, etc., são comuns no dia a dia de quem trabalha com mídia digital e compatíveis com o After Effects.


     4. Clique em Abrir. Eles serão importados para o projeto e ficarão disponíveis no painel Project.


    O painel Project



    Todos os arquivos que você importa para seu projeto passam a ser listados no painel Project. Isso quer dizer que os arquivos importados não foram incorporados ao seu projeto, mas estão vinculados a ele e não podem ser apagados de seu HD, pois isso faria com que seu conteúdo desaparecesse do seu projeto no After Effects.


    Além dos arquivos importados, o painel Project armazena todas as composições criadas em seu projeto, todas as camadas sólidas, de ajuste, os projetos do Premiere Pro e quaisquer outros itens gerados automaticamente.
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    A organização dos itens de seu projeto é feita por meio de pastas, que podem ser criadas pelo comando New Folder, disponível no menu File, ou pelo pequeno botão de pasta na barra inferior do painel, chamado Create a new Folder. O processo, a partir daí, é idêntico ao processo ao qual já estamos acostumados, tanto no Finder (macOS) como no Windows Explorer (Windows).


    O painel Timeline



    Pode-se dizer que a timeline do After Effects é um híbrido daquela que encontramos no Premiere Pro com o painel Layers do Photoshop. Nela, todos os itens importados ou criados são dispostos uns sobre os outros e compõem a nossa animação por meio de sobreposição e transparências. Tal qual no Photoshop, nós podemos definir diversos parâmetros que estabelecem a forma como as camadas superiores interagem com as inferiores, além de aplicar efeitos que manipulam as imagens e os textos ao longo do tempo, seja de maneira contínua, seja variando seus parâmetros por meio de quadros-chave, os famosos keyframes.
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    As opções na timeline são muitas e divididas em colunas, para facilitar tanto o acesso a todas as possibilidades quanto sua ocultação, o que se torna bastante importante quando precisamos de mais espaço para trabalhar.


    As principais colunas da timeline são as apresentadas a seguir.


    
      	
A/V Features: Tem opções para mostrar, ocultar e bloquear camadas, além de silenciar seu som.


      	
Source Name: Coluna na qual estão os nomes de cada camada e podemos renomeá-las, se necessário.


      	
Switches: Contém diversos botões liga/desliga para recursos específicos que definem, entre outras opções, a qualidade das imagens, de efeitos e de recursos 3D.


      	
Parent & Link: Possibilita a conexão de uma camada a outra para animações conjuntas.


      	
Time Ruler: Funciona como régua de tempo e é usada para definir o momento exato de cada mudança nas animações que criamos.

    


    Além disso, na barra inferior esquerda da timeline encontram-se três pequenos botões, estando o primeiro já ativo. Os outros dois abrem mais duas colunas importantes, explicadas abaixo.


    
      	
Transfer Controls: Para definir modos de mistura e transparências entre camadas.


      	
In/Out/Duration/Stretch: Colunas que permitem ajustes precisos numéricos na definição de tempo e velocidade de cada camada.

    


    No entanto, para que a timeline possa existir, é preciso primeiro definir uma composição, elemento primordial na construção de qualquer projeto no After Effects.


    Os painéis Composition, Footage e Layer



    Embora esses três painéis sirvam a propósitos distintos, é comum que a pessoa acabe se confundindo e não perceba quando está em um ou em outro. Isso porque, muitas vezes, abrimos algo neles que parece idêntico. A atenção aos detalhes é o que nos faz ter certeza sobre onde estamos, para não nos perdermos quando estivermos criando as animações.


    O painel Composition



    Para acessar o painel Composition, é preciso primeiro criar uma composição. Na verdade, a composição é o principal item de projeto do After Effects, pois sem ela nada existe. É como se ela fosse a tela vazia do Photoshop ou a página em branco do Illustrator. E é ela que dá acesso também à timeline.


    Você já deve ter percebido que a área central da interface do After Effects possui dois botões grandes, ambos dedicados à tarefa de criar a primeira composição de qualquer projeto. Como o objetivo agora é apenas acessar o painel Composition da maneira mais simples, execute as etapas descritas abaixo.


     1. No painel Project, clique no arquivo de vídeo Skateboard.mp4 que você importou. Ele será a base para a composição a ser criada nesse projeto.


     2. Com o vídeo selecionado, arraste-o para dentro do painel Composition ou para a timeline ainda vazia. Dessa forma, o After Effects criará a nova composição com as dimensões, a taxa de quadros por segundo e a duração do vídeo.
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    Como dito antes, esses grandes botões são dedicados a criar a primeira composição. New Composition é a opção para criá-la com os parâmetros que você desejar. Já o botão New Composition From Footage se refere à criação de uma composição com base em qualquer material que ainda não tenha sido importado para o projeto.


    Mas é somente agora, com a composição criada e a timeline definida, que você de fato pode ver para que serve o painel Composition. Ele mostra tudo o que você cria na timeline, processando suas animações e seus efeitos em tempo real.


    Na barra inferior do painel, você encontrará diversas funções, entre elas:


    
      	porcentagem de aproximação da tela;


      	qualidade de renderização da pré-visualização;


      	visualização de máscaras e transparências;


      	alternância entre câmeras e ângulos específicos em composições tridimensionais.

    


    Todos os principais recursos do painel Composition serão explorados à medida que avançarmos nos exercícios deste livro, capítulo a capítulo. Ao final, você terá uma noção exata de como trabalhar com o painel Composition em conjunto com a timeline e os demais painéis do After Effects.


    Os painéis Footage e Layer



    Muitas vezes, você notará que a visualização do painel Composition mudará. E possivelmente isso ocorrerá porque você abrirá ou o painel Footage ou o painel Layer, mesmo sem querer. Acredite, isso acontecerá com frequência.


    Se, a partir do painel Project, você der um duplo clique em qualquer arquivo, seu conteúdo será mostrado no painel Footage, que ocupará o mesmo espaço do painel Composition. O mesmo ocorrerá se você der um duplo clique em qualquer camada na timeline, porém o painel Layer é que será aberto.


    
      Footage é o nome dado a todo material bruto, sem edição. Ou seja, todo arquivo no painel Project é um footage, porque ali ele não está processado por nenhum dos efeitos ou quaisquer outros ajustes possíveis pelo After Effects.

    


    Esteja sempre de olho. Se, de repente, você perceber que está fazendo algo na timeline e nada está acontecendo na pré-visualização do painel Composition, as chances de você estar vendo o painel Layer ou mesmo o Footage são grandes. Basta clicar de volta no nome do painel Composition antes de seguir animando.


    Mas para que servem os painéis Footage e Layer? Ambos os painéis permitem que operações iniciais sejam feitas ao material bruto original, sem que as alterações realizadas nesse mesmo material já em uma composição sejam mostradas.


    Assim, mesmo que na composição uma determinada camada já tenha efeitos aplicados a ela, ao abri-la no painel Layer não veremos esses efeitos. Entretanto, ainda poderemos criar máscaras, pintar, apagar ou retocar imagens usando as ferramentas Brush, Eraser ou Clone Stamp, bem como definir pontos para análise de movimento ou criar uma seleção que ative automaticamente o recorte da imagem, função esta da ferramenta Roto Brush.


    
      [image: ]
    


    Já no painel Footage temos apenas alguns recursos básicos possíveis, como definição de corte com pontos de início (In Point) e fim (Out Point) da cena, a visualização de seu canal alfa ou máscara e botões para inserção do corte da cena na composição. A vantagem aqui é sempre trabalhar no material bruto e definir, a partir dele, como processá-lo e usá-lo no projeto.
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